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Welcome to 
ToolBox 
Software for 
Programming 
GE Interlogix 
Security 
Systems

ToolBox is a Windows® based program that saves you time by simplifying control 
panel programming. It will also save you the time and expense of a service call. Using 
only a PC, a modem, and a standard telephone line ToolBox makes creating new cus-
tomer accounts and updating the panel settings of existing customers simple and quick.

ToolBox is compatible with the following panels: CareTaker® Plus, UltraGard®, Com-
mander® 2000, Euro Commander®, Simon®, Concord™, Concord Express™ and Alle-
gro™.

Displaying Help Topics
This product offers extensive online help for menu options, field definitions, and other 
terms.

If you want to know more about a particular option, click inside that menu or dialog 
box, then press the F1 key. On-line help appears which is specific to the current input 
field. For general or indexed help select Contents from the Help menu.
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Part One:
Installing 
ToolBox

Checking Your ToolBox Package Before You Begin
Your ToolBox package should include:

• Three GE Interlogix ToolBox for Windows installation disks (3.5" high-density)

• This GE Interlogix ToolBox for Windows User’s Guide

Checking Your Hardware and Software
Note  
ToolBox has not been tested 
with Windows, 3.51, or Win-
dows ME. Table 1: Minimum System Configuration

Table 2: Modems Tested with ToolBox 

Backing Up Your Master Disks
Before you install ToolBox, make sure your original ToolBox disks are write-protected, 
then make a backup copy of each. See your computer’s reference or user’s guide for 
instructions on copying disks. Use the copy to install ToolBox, and store the original 
ToolBox installation disks in a safe place.

Stand Alone Computer Networked Computer

Computer Type IBM® or compatible IBM® or compatible

Processor Pentium 120 MHz or faster Pentium 200 MHz or faster

Hard Disk Space 20 MB 1 GB

Network Card NA 10 BaseT 10/100 MB Card 

Install Drive 3.5-inch floppy drive with 1.44 MB capacity

Operating System Windows® 95/98, NT 4.0 (or higher), and 2000

Display Display must be set to 800 x 600 with small fonts and 1024 x 768 with 
large fonts.

Modem A Hayes™ (or 100%-compatible) internal or external modem. See Table 
2 for a listing of modems that have been tested with ToolBox. You can 
order a compatible modem from GE Interlogix by calling 1-800-777-4841 
and ordering part number 60-719. When using an external modem, use 
a serial cable with all signals wired through. If you wire your own, you 
must dedicate a wire to DTR. DTR and DSR cannot be shared because 
ToolBox uses DTR to hang up the modem. 

Modem

AT&T Smartlink 14.4 (Internal)

Avatex® 1200 HC

Hayes™ Accura™ 14.4  Model 5300 AM

Hayes™ Accura™ 33.6 V.34  Model 5914US

Hayes™ Optima™Model 4007 AM

MICC 4824 

Practical Peripherals Mini 1200 SA (Part Number 60-
719)

Practical Peripherals PM144MT11

Securcomm DL 110 by DC Security

Super Modem 2400

TRON DF56.0 (Special)
3



Installing ToolBox
Windows must be installed on your computer before you can install ToolBox.

1. Turn on your computer and start Windows if it is not already running.
2. Insert ToolBox installation Disk 1 into your disk drive.
3. Click the Start button, then select RUN.

Note  
This ToolBox version con-
tains changes to the data-
base files from previous 
versions, so you must install 
the database files and 
import your old data, if you 
have any.

4. Type: a:\setup or b:\setup depending on the letter of the drive holding the 
installation disk. Click OK.
or
Use Window’s Explorer to access the floppy drive, then click on the file named 
“Setup.exe.”

5. Follow the automated installation procedure to complete the installation process.

The installation process will allow you to specify application, database, and admin-
istrator directories. Select directories either on the local hard disk or on a network 
drive.

Note  
If you choose a database 
directory already containing 
database files, ToolBox will 
create a backup directory 
(within the selected direc-
tory) for the existing files. 
You may choose to import 
the backup database at a 
later time.

6. When ToolBox for Windows is installed as 
described here, the ToolBox program group should 
appear in the Start menu.
4



Part Two: 
Getting Up and 
Running

Starting ToolBox

1. Select GE Interlogix ToolBox from 
the Start menu and click on the GE 
Interlogix ToolBox icon.

2. The Operator Login dialog box 
appears. Click inside the Operator 
ID field and type the default operator 
ID in all uppercase: ITI
Tab to, or click in, the Password 
field. Type the default operator pass-
word in all lowercase: password

3. Click OK or press Enter to accept 
the information.

4. After a successful login, a welcome box appears. Click OK to continue.

The ToolBox main menu appears along the top of the screen. 

Operator Setup
To add, edit, and delete operators or 
change operator passwords select Oper-
ator from the Setup menu. 

Note  
You must be logged in as an 
operator with “Full Access” 
to create, edit, or delete 
other operators.

Once the first operator is defined, the default operator ID (ITI) and password (password) 
are obsolete and will not work to log in to ToolBox. 

The Change Password option allows only the currently logged in operator to change 
their password.

Setting Up the Modem

1. Start ToolBox. The first time you start ToolBox you’ll see the message:
“Verify COM port selection by choosing Modem from the Setup menu. Be sure to 
use the OK button to close the Modem Setup Dialog.” 
Click OK to accept the message.

2. Choose Modem 
Selection from 
the Setup menu.

3. Select your 
modem from the 
list of available 
modems in the 
Modem Selec-
tion dialog box. 
(If you are using 
a GE Interlogix 
modem, select Securcomm DL110 (Speaker On).) Click OK.
5



4. From the Setup menu, select 
Modem or click on the 
Modem button on the toolbar. 
If you selected a modem in 
Step 3, the Modem Setup dia-
log box displays the automatic 
settings for Init String, Dial 
Prefix, Dial Suffix, and 
Answer String.

5. Select your modem’s COM 
port from the COM Port drop-
down menu. 

Important !  
Windows NT users must have the FIFO buffers disabled on the COM port ToolBox will be 
using. If they are not disabled, communications with alarm panels will fail due to the timin 
errors caused by data buffereing. ToolBox will remind you to disable the FIFO buffers, but 
does not automatically disable the buffers.

� To disable a port’s FIFO buffers see Table 3 below.

Table 3: Disabling FIFO buffers

6. Type the incoming phone line number for the modem in the Incoming Phone Num-
ber field.

Note  
You should not have to 
change the remaining 
modem settings if you are 
using a compatible modem. 
See Table 2 (in Part One) for 
a list of compatible modems. 
Refer to the Troubleshoot-
ing section if your modem 
isn’t working with ToolBox.

7. Click OK to accept the changes. A message may appear prompting you to restart 
the system. Click OK.

8. A COM Settings Changed message appears stating that the downloader must be 
restarted for any changes to take effect. Click OK to continue.

9. From the Logout menu, choose Exit. Click Yes in response to “Are you sure you 
want to exit?”

10. Restart if prompted, to enable the new modem setup. 

  
System Setup

The information in the System Setup dialog box determines how ToolBox will handle 
scheduled and unscheduled calls from panels.

Unscheduled Calls
A call is considered unscheduled if, when a panel calls in, there is no ToolBox job wait-
ing that matches its account number.

There are many situations in which a panel would call in to ToolBox. For Example:

• A customer may call in to receive a programming change if instructed to do so by 
the dealer.

• A central station may trigger a CALLDL, which tells the panel to call its down-
loader. (This is not available to Simon II, Simon III, Concord, Concord Express or 
Allegro panels, which don’t communicate with the CS-4000.)

• An installer may perform a full upload to save all programming prior to replacing a 
panel.

Windows Version Action

Windows 95/98 Start Button - Settings - Control Panel - System - Device Man-
ager - Ports (Click on the specific port) - Properties - Resources

Or, execute the Add New Hardware command and let Windows 
95/98 auto-detect the modem.

Windows NT 4.0 Start - Settings - Control Panel - Ports - (Double click on spe-
cial port) - Advanced

Windows 2000 Start - Settings - Control Panel - System - Hardware tab - Device 
Manager tab - Right Click on the port - Properties - Port Settings 
tab
6



• A dealer may download to a replacement panel, restoring previous settings.

• A dealer may want to update the ToolBox database with any settings made at the 
panel by performing an immediate update.

Load Conflicts
Some types of panels have the capability to call in and request the kind of load they 
want. The panel can request an upload, download, or any job that is waiting for it. If a 
panel requests one type of load and there is already a conflicting job scheduled for that 
account, then ToolBox will handle the discrepancy as you determine in the Load Con-
flicts section of the System Setup dialog box (Select System Setup from the Setup 
menu). You can choose to always abort the job, always do what ToolBox wants, or 
always do what the panel wants.

Auto Logout
Toolbox will automatically logout the user after 5 minutes of unattended use. This time 
interval can be set within a range of 1 to 30 minutes. Setting Auto Logout Time to 0 will 
disable this feature.

ToolBox will either: 
upload, download, or 
merge all unscheduled 
jobs

If the job is scheduled, but the panel is requesting 
a load that conflicts with the scheduled job, select 
how you would like ToolBox to handle it

ToolBox will either: 
upload, download, 
update, or merge all 
unscheduled jobs 
unless the panel 
requests something 
different

If there is no account 
for the panel that 
calls in, create one 
automatically

The number of minutes (0-30) before the system logs 
off the current operator (0 disables logout time)

Check to log network 
connection errors in 
the log file. If not 
checked, errors will 
appear in the status 
window

Select if you do no want 
ToolBox to accept any 
unscheduled job from 
any panel
7
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Part Three: 
Your ToolBox 
Accounts

Setting Up a New ToolBox Account

You can set up accounts without connecting to the actual panel.

1. From the 
Account menu, 
select New, or 
click on the 
New Account 
button on the 
toolbar. The 
Create New 
Account dialog 
box appears.

2. Select the panel 
type that 
matches the 
customer’s 
panel in the list. 
You can create 
your own tem-
plates for each panel.

3. Enter the 5-digit account number in the New Account Number field. This is the 
same number the CS-4000 or CS-5000 uses, without the dash (XX-XXX). Concord, 
Concord Express and Simon 3 allow account numbers from 1 to 10 digits.

Note  
Account Perfixes are dis-
abled in this version of Tool-
Box.

4. Select from the pull down menu an account prefix. The account prefix groups 
accounts by central station (see Creating Acccount Prefixes).

5. You can select a folder from the pull down menu. Folders are used to group 
accounts.

6.   Click the Create button. You can either 
edit the new account immediately, or return 
to the main screen. Let’s click Yes and edit 
the new account.

7. The title bar lists the account 
number and the panel type. All 
of the panel settings are 
grouped according to tabs.
9



Selecting an Existing ToolBox Account

You can select and edit existing accounts without connecting to the actual panel.

1. From the 
Account menu, 
choose Edit, or 
click on the 
Edit Account 
button on the 
toolbar. The 
Select Account 
dialog box 
appears.

2. Select the 
account you 
want to edit 
from the list. 
To sort by 
ascending or descending order, simply click on a column heading.

3. Click OK to open the account.

You can locate an account by entering any part of the account name, number, prefix or 
account comment field information. This is helpful when you don’t know the exact 
account number and need to narrow your selection.

Account Settings
All possible panel settings appear on a series of tabbed dialog boxes. Which settings 
appear on a tab depends on the panel type - different systems have different settings.

You may be familiar with features, upper 
sensor numbers, or options. To find out 
where in the tabbed dialog boxes a particu-
lar setting is, look up the panel name in 
Appendix A.

You can also look under Feature Numbers, 
Option Numbers, or Upper Sensor Num-
bers in the ToolBox on-line help. You can 
get Help at any time by simply clicking 
inside the menu or dialog box and pressing 
F1.

Creating Account Prefixes
You can create Account Prefixes, to organize large databases of accounts or to group 
accounts by central station. The Account Prefix function is disabled by default. To acti-
vate Account Prefixes, perform the following steps:

1. Open the ToolBox.ini file found in the Windows, or WinNT directory.
2. Under the “[SystemSetup]” section add the line “PrefixMenuEnable = 1”.
3. Save and then close the file.
10



��To Create Account Prefixes
1. From the Setup menu select Auto Create 

Accounts, then New Account Prefix.
2. In the Account Prefix field enter a 1–15 

character (0–9, A–Z) account prefix.
3. In the CS Phone Number field enter the 

central station phone number you want 
connected to the prefix.

4. In the Comment field 
enter a description of the 
account prefix or central 
station.
11
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Part Four: 
Setting Up a 
Job

Understanding Job Basics
ToolBox communicates with a panel only when a job is created that instructs ToolBox 
to do so. ToolBox defines a job as the combination of the connection type with the load 
type:

Connections to panels can go in one of two directions:

• ToolBox can accept calls from panels whether the call is expected or not. 
This is considered a call-in job.

• ToolBox can call individual panels. This is considered a call-out job.

There are three purposes for connecting to a panel, upload, download, and merge:

Upload from Panel
Upload from Panel reads all loadable informa-
tion from a panel and saves it in the ToolBox 
account. An upload copies all settings, over-
writing any previous loadable account informa-
tion.

Use Upload from Panel to get your previously 
installed panels into the ToolBox database.

Download to Panel
Download to Panel writes all loadable account 
information from the ToolBox account to the 
panel. It will overwrite all previous settings in the 
panel. 

Use Download to Panel to reload all of a panel’s 
settings—when replacing a panel, for example.

Merge with Panel
Merge with Panel was designed specifically for 
the purpose of adding a new account to the Tool-
Box database after a new system is installed. 

To incorporate a new system into the ToolBox 
database:

1. Learn in touchpad and sensor information 
on-site.

2. Enter all other settings into the ToolBox 
account.

3. Select Merge with Panel in the Job Informa-
tion dialog box. This enables a list of cate-
gory items from which you can select to 
download to the panel. If you would like to 
upload the panel settings to the ToolBox 
account, leave the item unselected. 
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Creating a Job
Jobs can be created at any time and stored until the designated Start Time. For instance, 
if an area code changes, you can schedule the accounts affected to call out so ToolBox 
can download the new code to each panel.

Preparing a Job in ToolBox
1. From the Jobs menu, select New, or click on the New Job button on the toolbar. The 

Create New Job dialog box appears.

2. Select the account that will be in the new job.
3. Click the Create button to create the new job. The Job Information dialog box 

appears. (See the figure on the next page.)
4. Enter the settings for the job. You don’t need to run the job immediately, but the fol-

lowing criteria must be met in order for the jobs to run:
• The on-site phone line must be connected to the panel.

• The modem must be turned on at the computer running ToolBox.

• The ToolBox software must be running so that panels calling in can 
reach ToolBox.

5. An onscreen message may appear stating “Start time is passed. Job will begin 
immediately. Accept?” Click Yes. ToolBox is now ready to accept call-in jobs or to 
execute call-out jobs. ToolBox will make its calls out when the modem is free, 
unless a later start time is specified.
14



When the Panel is Calling ToolBox . . .
Follow these steps to prepare the panel to call in to ToolBox:

1. Make sure the panel is connected to the phone line.
2. Program the panel account number into the panel.
3. Program the ToolBox modem phone number into the panel according to Table 4.

Table 4:  Initiating the Call-In Job

Who will make the call Premises phone num-
ber found in the 
Phones tab

Click to stay on line 
with the panel after the 
job is finished

If Merge with panel is 
selected, choose the 
items to be down-
loaded to panel

Click to display 
advanced features

When the job runs, the 
account number and 
prefix will change; the 
old account will no 
longer exist

The job will not run 
before Start Time and 
will not run later than 
Stop Time

Click here to allow the 
job to be run before the 
start time if an installer 
on-site initiates a call to 
ToolBox

Keep rescheduling 
this job as an 
Upload/Download 
until the Stop Time

What the job will 
accomplish

Feature disabled in this 
software release

Panel Type Initial Installation Call-In to ToolBox Subsequent Call-Ins

CareTaker 
Plus

At the panel, program ToolBox’s phone number as the 
primary 
phone number. Enter primary access CODE + 8.

Not supported.

Commander 
2000

LifeGard Press and hold the Test button until “Phone test” is 
announced.

Euro
Commander

1. At the panel, program ToolBox’s phone number as the 
downloader phone number. (Phone 3 is the downloader 
phone number on versions 2.0 and greater.)
2. Enter CODE + COMMAND + 8.

CODE + COMMAND 
+ 8

Concord
Panels

1. Program ToolBox’s phone number, then the account 
number.
2. Enter:
8 + CODE + 7 + 0 to request a ToolBox job, whatever it is.
8 + CODE + 7 + 1 to request a download.
8 + CODE + 7 + 2 to request an upload.

Enter one: 
8 + CODE + 7 + 0
8 + CODE + 7 + 1
8 + CODE + 7 + 2
15



Concord, Concord Express, Simon, Euro Commander V2, and UltraGard store a sepa-
rate downloader phone number, which is distinct from reporting phone numbers. The 
UltraGard downloader phone number is only programmable from ToolBox or a CS-
4000.

When ToolBox is Calling the Panel . . . 
Keep in mind that when ToolBox calls the panel, the phone is going to ring. Make sure 
that it’s not going to disturb anyone before starting a call-out job.

Follow these steps for a panel to accept a call-out job from ToolBox:

1. Make sure the premises phone number is entered correctly in the Phones tab.
2. Program the ToolBox modem phone number into the panel according to Table 4.

The panel needs to be set correctly before it can accept the call from ToolBox. The set-
ting depends on the panel type, as shown in Table 5.

Table 5: Panel Settings for Call-out Jobs

Simon 1. At the panel, program ToolBox’s phone number as the 
downloader phone number (Option 6). 
2. Program the panel account number into the panel 
(Option 7).
3. At the panel, press the Test button until the panel says, 
“DL phone test,” then press the Done button.

Press the Test button 
until the panel says, 
“DL phone test,” then 
press the Done but-
ton.

UltraGard Since you can’t program the downloader phone number 
at the panel, do this upon initial installation:
1. At the panel, program ToolBox’s phone number as the 
primary phone number.
2. Set the UltraGard panel’s Downloader Access (F33) to 
ON at the panel. Downloader Access cannot be set from 
ToolBox.
3. Enter primary access CODE + 8 to initiate a CS phone 
test.

Enter primary access 
CODE + COMMAND 
+ 8.

CS-4000 users:
See CALLDL.

Panel Type Initial Installation Call-In to ToolBox Subsequent Call-Ins

Panel Type Accepting ToolBox Calls

CareTaker Plus Enter the primary access CODE + 8 at the panel when the onsite phone rings.

Commander 
2000

LifeGard After 3 rings, start a phone test.

Euro Com-
mander

Concord 
Concord 
Express

In order for the panel to accept a ToolBox call:
–In User Programming, the Downloading setting on the Options menu must be 
turned ON.
–In Installer Programming, the Remote Access setting on the Phone Options 
menu must be turned ON.
–The downloader phone number must be programmed at the panel.
Ring-Hang-Ring can be used to access the panel if, in User Programming, the 
Ring-Hang-Ring setting on the Phone Options menu is turned ON. 
The panel answers on the eigth ring if, in Installer Programming, the Toll Saver 
setting on the Phone Options menu is turned ON. If it is turned OFF, the panel 
answers after 12 rings.
To answer before the 8th or 12th ring, someone onsite can enter:
8 + CODE + 7 + 0
8 + CODE + 7 + 1
8 + CODE + 7 + 2 
16



Modifying a Job
After a job is created, it can be edited, cop-
ied, deleted, or simply viewed by choosing 
an option from the Jobs menu.

Copying a Job
All the settings from one account can be 
copied under another account number. 
(Account numbers cannot be duplicated.)

Editing a Job
Once a job is scheduled, you can still go 
back into the Job Information dialog box and make changes to the job settings.

Note  
You cannot access (edit) a 
job currently in progress.

Viewing a Job
Viewing a job means only that. You can only look at the job settings under View. If you 
want to change the settings, choose Edit instead.

Deleting a Job
Exiting ToolBox does not delete a job. To stop a job that is in progress, simply delete it 
from the Jobs menu. You could also click the Abort this Job button in the Job Status 
window.

Job Logs
Once jobs have been performed, any job communication information will be stored as 
logs. Use the Jobs menu to view or delete logs. To view any log information about an 
account that is currently being edited, select View Account Log from the Jobs menu.

Status Bar
At the bottom of the ToolBox window is a status bar which displays modem status 
information.

Job Status Window
The Job Status window opens automatically when ToolBox is opened. It displays infor-
mation regarding the outstanding job count, the job currently executing, and the last job 
run.

Simon The Simon panel can answer on or before the 12th ring using Ring-Hang-Ring 
(Option 27). 

UltraGard Since the panel answers on the twelfth ring, no one need be present. To answer 
manually before the twelfth ring, enter the primary access CODE + COMMAND 
+ 8. 
Automatic twelfth-ring answering is dependent upon Toll Saver’s setting 
(F03: ON=8 rings, OFF=12 rings) and Remote Access (F00: ON=allows remote 
access).

Panel Type Accepting ToolBox Calls
17



 Logging Out or Exiting ToolBox
Note  
Exiting ToolBox does not 
delete a job. To stop a job 
that is in progress, simply 
delete it from the Jobs 
menu.

Once you are finished using ToolBox to edit accounts or create jobs, you have the fol-
lowing options:

• Log out, leaving ToolBox running so it can continue to process outstanding jobs. 
(Choose Logout from the Logout menu.)

• Exit ToolBox completely. (Choose Exit from the Logout menu.) This will stop the 
execution of any existing jobs.

After ToolBox has been shut down and reopened again, any existing job must be 
restarted.

Prefix of current or last 
job

Account number of 
current or last job

Call-in or call-out

Download, upload, 
update, merge

Jobs scheduled to run

For purposes of Ring-
Hang-Ring: Click while 
a call-out job is dial-
ing. This causes Tool-
box to hang up and 
wait 10 seconds before 
re-dialing.

Cancel the job 
currently running

Bar representation of portion of cur-
rent job already completed
18



Part Five: 
Database 
Management

Backing Up and Importing Customer Accounts
Backing up the customer database should be a daily task and part of your disaster recov-
ery plan. Backing up the administrator database should be done periodically to retain 
modem and operator settings.

Note  
If you did not split the data-
base by specifying a differ-
ent administrator directory 
during installation then 
administrator files will be in 
the customer database 
directory. Backing up the 
customer database will auto-
matically back-up adminis-
trator files.

Backup the Database/Administrator Files
1. Create a backup folder outside the ToolBox database or 

administrator directory where you will store backup files.
2. When ToolBox is not running, copy all .mdx and .dbf files 

into the respective backup database or administrator directory.

Restore the Database/Administrator Files
In the event that the PC is turned off while ToolBox is open or if the application freezes 
for some reason, files could be rendered inaccessible the next time ToolBox is started.  
Use the procedure outlined in the “Importing Databases” section to restore database/
administrator files. In order for the following steps to be useful, the backup files must be 
up-to-date.

Importing Databases
At some time it may be necessary to import one or more databases into ToolBox. Rea-
sons for doing this include:

• You need to merge a current or previous version of a ToolBox database into
ToolBox.

• You need to replace a corrupt database with a backup database.

Use Table 6 as a guide for importing from/to single and split database types. The indi-
cated source and destination directories must be specified before converting.

Table 6: Database importing information

1. Open the ToolBox DB Importer program from the Start menu.

2. From the File menu choose the Source direc-
tory (either database or administrator).

Task Database 
Source

Database 
Destination

Administrator 
Source

Administrator 
Destination

Single »Single x x

Single » Split x x x

Split » Split x x x x

Split » Single x x x
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3. Select the database or 
administrator directory 
you want to import as the 
Source directory and click 
Open.

4. Repeat steps 2 and 3 if 
necessary.

5. From the File menu 
choose the database or administrator Desti-
nation directory.

6. Select the appropriate 
Destination directory and 
click Open.

7. Repeat steps 5 and 6 if 
necessary.

8. Once all Source and Destina-
tion directories have been spec-
ified, click Convert on the 
Importer menu bar to import 
the selected database directo-
ries.

Note  
The Database Importer can-
not convert databases con-
taining more than 10,000 
accounts.
20



Part Six: 
Troubleshooting

Panels

Starting ToolBox

Communications/Modem

Problem Solution

You are unsure of the UltraGard 
version at the panel.

Use the Panel Version Command to determine the UltraGard 
version in use. The panel must be in the normal operating 
mode (RUN).
1. From a touch-tone phone, press *CODE#7
2. The touchpad displays an 8-digit number. The first 3 digits 
indicate a family product code and the last 5 digits indicate the 
software version.
For example: 75*576**
3. Interior speakers and touch-tone phones also announce the 
information. Using the example above, you would hear, “Sys-
tem seven five, level five-seven-six-level-level.”
If you can’t perform this command, you have an UltraGard 1.x.

You are unsure of the Com-
mander 2000 version at the 
panel.

Cycle power to the panel. The panel responds by saying, “Sys-
tem x. 
Sensor y,” where x is the panel version and y is the number of 
zones.

Problem Solution

Errors occur when starting Tool-
Box.

Make sure that your CONFIG.SYS file contains the line 
FILES=80 
(or greater). If you change CONFIG.SYS, you must reboot your 
computer before running ToolBox. (Not applicable when run-
ning ToolBox on Windows NT.)

Problem Solution

Modem doesn’t dial. Make sure cable includes wire for DTR. See page 3.

ToolBox displays the message, 
“Cannot access communica-
tions port.”

1. Choose Modem Selection from the Setup menu.
2. Verify that the correct communications port is selected in the 
Modem Selection dialog box.
3. Close any program that might be using the selected commu-
nications port.
4. If the problem persists, try using the modem with another 
communications program. 
5. Make sure FIFO is turned off for Windows NT.

ToolBox displays the message, 
“A change has been made to 
your SYSTEM.INI file. Close 
ToolBox and restart Windows.”

In order to communicate with a Commander 2000, a LifeGard, 
or an UltraGard using code +8, the SYSTEM.INI must contain 
the following line in the [386Enh] section:
“ComxFifo=0” where x=the communications port number. The 
Modem Setup Dialog automatically adds this line to the SYS-
TEM.INI file when closed using the OK button.

ToolBox displays the message, 
“Verify comm port selection by 
choosing Modem from the 
Setup menu. Be sure to use the 
OK button to close the Modem 
Setup Dialog.”

This message is closely related to the previous message in this 
table. When ToolBox is started, it checks the SYSTEM.INI file 
for the existence of the ComxFifo=0 line. If it does not find it, 
this message is displayed.

ToolBox displays the message,
“Internal communications error.”

The user cannot do anything to correct this problem. The pro-
gram entered into a state which was not anticipated. 
If the problem persists, the user should report it to Technical 
Services.
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ToolBox displays the message, 
“Cannot configure communica-
tions port.”

An error was detected when configuring the communications 
port to the desired baud rate/parity/word length. Try using a dif-
ferent com port (or a different modem in the case of an internal 
modem).

ToolBox displays the message, 
“Modem error . . . correct prob-
lem and restart ToolBox.”

1. Check Table 2 (Part One) to make sure that your modem is 
compatible.
2. Make sure that the modem is on, connected to the PC, and 
that the 
correct COM port is selected.
3. Verify modem cable is in good condition. Replace if neces-
sary.
4. Exit out of ToolBox.
5. Try using the modem with another communications pro-
gram. Change the modem settings until the modem responds 
to AT commands.
6. Try communicating with ToolBox again.
7. If the modem still does not work, call Technical Services. 

Problem Solution
22



Appendix A
Locating Panel 
Features in the 
Tabs

Concord and Concord Express
The tabs in ToolBox coordinate with the menus in Installer Programming 
(8 + Installer Dealer Code + 0 + 0). Concord and Concord Express do not reference fea-
ture or upper sensor numbers.

CareTaker Plus 

Feature Number Name of Feature CareTaker Plus Tab 
Location

00 Remote Access Phone Options tab

01 Ring-Hang-Ring Phone Options tab

02 Exterior Siren Delay Siren Options tab

03 Toll Saver Phone Options tab

04 Low Battery Report Frequency Reporting tab

05 Supervisory Report Frequency Reporting tab

06 Dialer Abort Phone Options tab

07 Access Key Type Phone Options tab

11 Interior Sirens—Alarms Only Siren Options

12 Zone Restorals Reporting tab

13 Battery Restoral Reporting tab

14 Phone Voltage Test Phone Options tab

15 Alarm Verification Reporting tab

16 Disable Trouble Beeps Siren Options tab

17 24 Hour Zone Tamper Reporting tab

21 Immediate Supervisory Trouble Beeps Siren Options

22 DTMF Dialing Phone Options tab

25 Arming Button Function Touchpad Options tab

32 Star Key Function Touchpad Options tab

77 Enable Tamper Touchpad Options tab

78 Freeze Alarm Reporting tab

79 No Activity Reporting tab

80 Fire Panic Touchpad Options tab

81 Police Panic Touchpad Options tab

82 Auxiliary Panic Touchpad Options tab

83 Manual Phone Test Phone Options tab

84 Opening Reports Reporting tab

85 Closing Reports Reporting tab

86 Duress Reporting Reporting tab

87 Force Armed Reporting tab

88 Energy Saver Accessory Modules tab 
(Click More button when 
Energy Saver is selected as 
a unit.)

89 Enable Low Battery/Supervisory Touchpad Options tab

90 AC Failure Reporting tab
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Commander 2000 and Euro Commander 

  

91 Low CPU Battery Reporting tab

92 CPU Tamper Reporting tab

93 Automatic Phone Test Phone Options tab

94 Receiver Failure Reporting tab

95 CPU Back in Service Reporting tab

96 Fail to Communicate Phone Options tab

Feature Number Name of Feature CareTaker Plus Tab 
Location

Feature Number Name of Feature Commander 2000 Tab 
Location

20 Audio Verification Siren/Accessory tab

21 DC Main Power Siren/Accessory tab

22 DTMF Dialing Phones tab

23 Opening/Closing Reports in Buffer Reporting tab

24 Hardwire Input Configuration Sensors tab

25 Keychain Touchpad Arming Button 
Function

Touchpad Options tab (Ver. 4 
only)

25 Magic Key Security tab (Ver. 3 only)

26 Command Button Disarm Security tab

27 CPU Alarm Mute Siren/Accessory tab

30 Immediate Low Battery Reports Reporting tab (Ver. 4 only)

31 Protest Beeps on RF Disarm Siren/Accessory tab (Ver. 4 
and Euro)

32 Programmable Burglary Siren and Light 
Operation

Siren/Accessory tab 
(EuroCommander Ver. 2 
only)

33 Inverted Self Activated Bell (SAB) Siren/Accessory tab
(EuroCommander Ver. 2 
only)

34 Latching of Self Activated Bell (SAB) Siren/Accessory tab
(EuroCommander Ver. 2 
only)

35 Latching vs. Single Hardwired Interior 
Siren (HIS) Trip

Siren/Accessory tab
(EuroCommander Ver. 2 
only)

36 Latching vs. Single Hardwired Exterior 
Siren (HES) Trip

Siren/Accessory tab
(EuroCommander Ver. 2 
only)

37 Latching vs. Single Failure to Communi-
cate (FTC) Trip

Siren/Accessory tab
(EuroCommander Ver. 2 
only)

Upper Sensor 
Number Name of Feature Commander 2000 Tab 

Location

80 Fire Panic Touchpad Options tab

81 Police Panic Touchpad Options tab

82 Auxiliary Panic Touchpad Options tab
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LifeGard 

83 Manual Phone Test Phones tab

84 Opening Reports Reporting tab

85 Closing Reports Reporting tab

86 Duress Reporting Reporting tab

87 Force Armed Reporting tab

89 Enable Low Battery/Supervisory Touchpad Options tab

90 AC Failure Reporting tab

91 Low CPU Battery Reporting tab

92 CPU Tamper Reporting tab

93 Automatic Phone Test Phones tab

94 Receiver Failure Reporting tab

95 CPU Back in Service Reporting tab

96 Fail to Communicate Phones tab

97 Siren Supervision Siren/Accessory

98 Auto Event Buffer Dump Reporting tab

Upper Sensor 
Number Name of Feature Commander 2000 Tab 

Location

Feature Number Name of Feature LifeGard Tab Location

20 Audio Verification Siren/Accessory tab

21 DC Main Power Siren/Accessory tab

22 DTMF Dialing Phones tab

23 Opening/Control Reports in Buffer Reporting tab

24 Hardwire Input Configuration Sensors tab

27 CPU Alarm Mute Siren/Accessory tab

30 Immediate Low Battery Reports Reporting tab

32 Disable Away Mode Supervision of Pan-
ics

Reporting tab (Ver. 5 only)

34 External Output Siren/Accessory tab

35 Allow Night Arming/Activity Level Security tab

79 No Activity Reporting tab

80 Fire Panic Touchpad Options tab

81 Police Panic Touchpad Options tab

82 Auxiliary Panic Touchpad Options tab

83 Manual Phone Test Phones tab

84 Opening Reports Reporting tab

85 Closing Reports Reporting tab

89 Enable Low Battery/Supervisory Touchpad Options tab

90 AC Failure Reporting tab

91 Low CPU Battery Reporting tab

93 Automatic Phone Test Phones tab

94 Receiver Failure Reporting tab

95 CPU Back in Service Reporting tab
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Simon 1 and 2

96 Fail to Communicate Phones tab

98 Auto Event Buffer Dump Reporting tab

Feature Number Name of Feature LifeGard Tab Location

Option Number Name of Feature Simon Tab Location

01 Panel Piezo Beeps Misc tab

02 Panel Voice Misc tab

03 Latchkey Time Timers tab

04 Phone 1 Number Phones tab

05 Phone 2 Number Phones tab

06 Downloader Phone Phones tab

07 Account Number Created when account is cre-
ated 

08 Phone Lock Security tab

09 Downloader Access Code Security tab

10 Entry Delay Timers tab

11 Exit Delay Timers tab

12 Phone 1 Modifier Phones tab

13 Phone 2 Modifier Phones tab

14 DTMF Dialing Phone Options tab

15 No Activity Timeout Timers tab

16 Auto Phone Test Interval Timers tab

17 Dialer Delay Phone Options tab

18 Alarm Cancel Timers tab

19 RF Transmitter Timeout Timers tab

20 Manual Phone Test Phone Options tab

21 Opening Reports Misc tab

22 Closing Reports Misc tab

23 Force Armed Misc tab

24 AC Failure Misc tab

25 Low CPU Battery Misc tab

26 Communications Failure Phone Options tab

27 Ring-Hang-Ring Phone Options tab

28 No Delay from Keychain Misc tab

29 Panel Piezo Alarm Misc tab

30 Panic Alarms Misc tab

31 Day of Week Programmed automatically 
by ToolBox

32 300 BPS Enable Phone Options tab

33 Audio Verification Audio Verification tab (Ver. 2 
Only)

34 Fail to Open Time Timers tab (Ver. 2 Only)

35 Fail to Close Time Timers tab (Ver. 2 Only)
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Simon 3

36 Motion Lockout Start Time Light Control tab (Ver. 2 
Only)

37 Motion Lockout Stop Time Light Control tab (Ver. 2 
Only)

38 Auto Arm Security tab (Ver. 2 Only)

39 Siren Timeout Timers tab (Ver. 2 Only)

40 Trouble Beeps Misc tab (Ver. 2 Only)

41 Chime Voice Misc tab (Ver. 2 Only)

42 Speaker Level Misc tab (Ver. 2 Only)

43 Pager Number Phones tab (Ver. 2 Only)

44 Pager Modifier Phones tab (Ver. 2 Only)

45 Sensor Alarm Restoral Misc tab (Ver. 2 Only)

46 Fire Shutdown Audio Verification tab (Ver. 2 
Only)

47 Mode (Instant or Call Back) Audio Verification tab (Ver. 2 
Only)

48 Panic Talk (Listen or Listen & Talk) Audio Verification tab (Ver. 2 
Only)

49 Rechargeable Battery Misc tab (Ver. 2 Only)

50 RF Jam Detect Misc tab (Ver. 2 Only)

51 24 Hour Battery Test Misc tab (Ver. 2 Only)

52 High Level Status Misc tab (Ver. 2 Only)

53 Hardwire Siren Supervision Misc tab (Ver. 2 Only)

54 Audible Police Panic Misc tab (Ver. 2 Only)

Option Number Name of Feature Simon Tab Location

Option Number Name of Feature Simon Tab Location

01 Panel Piezo Beeps Siren Options/Misc tab

02 Panel Voice Siren Options/Misc tab

03 Latchkey Option Timers tab

04 Primary Phone Number Phones tab

05 Secondary Phone Number Phones tab

06 Downloader Phone Number Phones tab

07 Account Number Created when account is cre-
ated 

08 Phone Lock Security tab

09 Downloader Code Security tab

10 Entry Delay Timers tab

11 Exit Delay Timers tab

12 Phone Mod 1 Phones tab

13 Phone Mod 2 Phones tab

14 DTMF Phone Options tab

15 No Activity Report Timers tab

16 Auto Phone Test Timers tab
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17 Dialer Delay Phone Options tab

18 Alarm Cancel Timers tab

19 RF Timeout (SUPSYNC) Timers tab

20 Manual Phone Test Phone Options tab

21 Opening Reports Reporting tab

22 Closing Reports Reporting tab

23 Force Armed Report Reporting tab

24 AC Power Failure Report Reporting tab

25 CPU Low Battery Report Reporting tab

26 Fail to Communicate Phone Options tab

27 Ring/Hang/Ring Phone Options tab

28 No Delay from Keychain Touchpad Siren Options/Misc tab

29 Panel Piezo Alarms Siren Options/Misc tab

30 Panic Alarms Siren Options/Misc tab

31 Downloader Enable Security tab

32 300 Baud Central Station Communica-
tions

Phone Options tab

33 Audio Verification Audio Verification tab

34 Fail to Open Timers tab

35 Fail to Close Timers tab

36 Sensor Activated Light Lockout Start 
Time

Light Control tab

37 Sensor Activated Light Lockout Stop 
Time

Light Control tab

38 Auto Arm Security tab

39 Siren Time Out Timers tab

40 Trouble Beeps Siren Options/Misc tab

41 Chime Voice Siren Options/Misc tab

42 Speaker Level Siren Options/Misc tab

43 Pager Phone Number Phones tab

44 Pager Phone Mod 3 Phones tab

45 Sensor Alarm Restoral Reporting tab

46 Fire Shutdown - AVM Audio Verification tab

47 Audio Verification Mode Audio Verification tab

48 Panic Talk - AVM Audio Verification tab

49 Arming LEDs Shutdown Timers tab

50 RF Jam Detect Siren Options/Misc tab

51 24 Hour Tamper Reporting tab

52 Unvacated Premises Timers tab

53 Hardwire Siren Supervision Siren Options/Misc tab

54 Access Code Length Access Code tab

55 Status Beep Volume Siren Options/Misc tab

56 Call Waiting Phone Options tab

57 Supervisory Tamper Report Reporting tab

Option Number Name of Feature Simon Tab Location
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UltraGard 

58 Remote Touchpad Arming Siren Options/Misc tab

59 Exit Extension Security tab

60 Secure Arming Security tab

61 Demo Mode Siren Options/Misc tab

62 Supervisory Protest Timers tab

63 24 Hour Clock Timers tab

64 No Arm on Panel Low Battery Security tab

65 No Usage Report Reporting tab

66 External Siren Delay Siren Options/Misc tab

67 Quick Exit Security tab

68 Swinger Shutdown Reporting tab

69 SIA Limits Timers tab

70 Line Cut Detection Timers tab

71 Programming Report Reporting tab

72 Supervisory Time Timers tab

73 Modem Sensitivity Phone Option tab

74 Panel Police Panic Audio Siren Options/Misc tab

75 VOX Mic Gain Audio Verification

76 VOX Gain Range Audio Verification

77 Manual Mic Gain Audio Verification tab

78 VOX Receiver Gain Audio Verification tab

79 Panel Tamper Alarm Reporting

80 Alarm Report Verification Reporting

81 Heating Set Point Siren Options/Misc tab

82 Cooling Set Point Siren Options/Misc tab

Option Number Name of Feature Simon Tab Location

Feature Number Name of Feature UltraGard Tab Location

00 Remote Access Phone Options tab

01 Ring-Hang-Ring Phone Options tab

02 Exterior Siren Delay Siren Options tab

03 Toll Saver Phone Options tab

04 Low Battery Report Frequency Reporting tab

05 Supervisory Report Frequency Reporting tab

06 Dialer Abort Phone Options tab

07 Access Key Type Phone Options tab

11 Interior Sirens–Alarms Only Siren Options tab

12 Zone Restorals Reporting tab

13 Battery Restoral Reporting tab

14 Phone Voltage Test Phone Options tab

15 Alarm Verification Reporting tab

16 Trouble Beeps on Supervisory Siren Options tab

17 24-Hour Zone Tamper Reporting tab
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20 Audio Verification Audio Verification tab

21 Immediate Supervisory Trouble Beeps Siren Options tab

22 DTMF Dialing Phone Options tab

23 Event Buffer Control Reporting tab

25 Arming Button Function Touchpad Options tab

32 Star Key Function Touchpad Options tab

33 Downloader Access Cannot be set in ToolBox

35 Phone Panics Phone Options tab

36 Local Phone Control Phone Options tab

37 Quick Arm Security tab

40 Smoke Verification Accessory Modules tab

41 Siren Verification Siren Options tab

42 Enable Source Tracking Touchpad Options tab

43 Demo Kit Reporting tab

44 Constant Exterior Siren Siren Options tab

45 Key Switch Arming Security tab

46 Daylight Savings Update Timers tab

47 UL Beeps Time Siren Options tab

77 Enable Tamper Touchpad Options tab

78 Freeze Alarm Reporting tab

79 No Activity Reporting tab

80 Fire Panic Touchpad Options tab

81 Police Panic Touchpad Options tab

82 Auxiliary Panic Touchpad Options tab

83 Manual Phone Test Phone Options tab

84 Opening Reports Reporting tab

85 Closing Reports Reporting tab

86 Duress Reporting Reporting tab

87 Force Armed Reporting tab

88 Energy Saver Module Accessory Modules tab 
(Click More button when 
Energy Saver is selected as 
a unit)

89 Enable Low Battery/Supervisory Touchpad Options tab

90 AC Failure Reporting tab

91 Low CPU Battery Reporting tab

92 CPU Tamer Reporting tab

93 Automatic Phone Test Phone Options tab

94 Receiver Failure Reporting tab

95 CPU Back in Service Reporting tab

96 Fail to Communicate Phone Options tab

98 Auto Event Buffer Dump Reporting tab

Feature Number Name of Feature UltraGard Tab Location
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Index
A
account prefix 9
Accounts (ToolBox)

changing account number 14
accounts (ToolBox)

entering or changing account settings 10
selecting an existing 10
setting up a new 9

adding a new ToolBox account 13
AT&T Smartlink 14.4 modem 3
Avatex 1200 HC modem 3

C
call-out connection

accepting at the panel 16
making 16

CareTaker Plus
accepting the call-out job 16
initial installation and subsequent call-ins 15

changing a job 17
COM ports 6
Commander 2000

accepting the call-out job 16
identifying the panel version 21
initial installation and subsequent call-ins 15

Concord
accepting the call-out job 16
initial installation and subsequent call-ins 15

Concord Express
accepting the call-out job 16
initial installation and subsequent call-ins 15

Convert 20
copying a job 17

D
defaults, password and operator 5
deleting a job 17, 18
Downloader Access 16
downloader phone number 16
DSR, dedicating wires to 3
DTR, dedicating wires to 3

E
editing a job 17
Euro Commander 15
exiting ToolBox 18

F
FIFO buffers, installing on Windows NT 6
Full Download 13
Full Upload 13

G
GE Interlogix modem

ordering information 3, 5

H
hardware requirements for ToolBox 3

Hayes
Accura 144 modem 3
Optima modem 3

Help, displaying topics in online 1

I
importing database files 20
Importing Databases 19
initial installation call-in connection 15
initiating a central station phone test (UltraGard) 16
installing

a new system 13
ToolBox 4
ToolBox on Windows NT 6

J
job

changing 17
copying 17
deleting 17
editing 17
viewing 17

job logs 17
Job Status window 17

L
LifeGard

accepting the call-out job 16
initial installation and subsequent call-ins 15

logging out of ToolBox 18

M
Merge Load 13
MICC 4824 modem 3
modems

incoming phone field for the 6
ordering one from GE Interlogix 5
setting up 5
those tested with ToolBox 3

N
New Account Prefix 9

O
online Help 1
operator default 5

P
password default 5
Practical Peripherals Mini 1200 SA modem 3

R
replacing a panel 13
requirements, hardware and software 3
restoring the database 19
RF touchpad and sensor information, uploading 13

S
Securcomm DL 110 by DC Security 3
selecting

an existing ToolBox account 10
sensor information, uploading 13
Index 31



sensors, uploading 13
setting up

a new ToolBox account 9
the modem 5

Simon
accepting the call-out job 17
initial installation and subsequent call-ins 16
Options

06 (Downloader Phone Number) 16

27 (Ring/Hang/Ring) 17

Simon III 27
software requirements for ToolBox 3
status bar 17
Super Modem 2400 3
system configuration 3

T
TBImporter 20
ToolBox 5.0 DB Importer 19
ToolBox accounts

entering or changing account settings 10
topics, displaying online Help 1
touchpad and sensor programming 13
touchpad information, uploading 13

U
UltraGard

accepting the call-out job 17
Feature Numbers

00 (Remote Access) 17

33 (Downloader Access) 16

identifying the panel version 21
initial installation and subsequent call-ins 16

uploading touchpad and sensor information 13

V
viewing a job 17

W
Windows NT 6
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	ToolBox for Windows
	User’s Guide

	Contents
	Welcome to ToolBox Software for Programming GE Interlogix Security Systems
	Displaying Help Topics

	Part One: Installing ToolBox
	Checking Your ToolBox Package Before You Begin
	Checking Your Hardware and Software
	Note ToolBox has not been tested with Windows, 3.51, or Win dows ME.
	Table 1: Minimum System Configuration
	Table 2: Modems Tested with ToolBox
	Backing Up Your Master Disks
	Installing ToolBox
	1. Turn on your computer and start Windows if it is not already running.
	2. Insert ToolBox installation Disk 1 into your disk drive.
	3. Click the Start button, then select RUN.


	Note This ToolBox version con tains changes to the data base files from previous versions, so you must install the database files and import your old data, if you have any.
	4. Type: a:\setup or b:\setup depending on the letter of the drive holding the installation disk. Click OK. or Use Window’s Explorer to access the floppy drive, then click on the file named “Setup.exe.”
	5. Follow the automated installation procedure to complete the installation process. The installation process will allow you to specify application, database, and admin istrator directories. Select directories either on the local hard disk or...

	Note If you choose a database directory already containing database files, ToolBox will create a backup directory (within the selected direc tory) for the existing files. You may choose to import the backup database at a later time.
	6. When ToolBox for Windows is installed as described here, the ToolBox program group should appear in the Start menu.


	Part Two: Getting Up and Running
	Starting ToolBox
	1. Select GE Interlogix ToolBox from the Start menu and click on the GE Interlogix ToolBox icon.
	2. The Operator Login dialog box appears. Click inside the Operator ID field and type the default operator ID in all uppercase: ITI Tab to, or click in, the Password field. Type the default operator pass word in all lowercase: password
	3. Click OK or press Enter to accept the information.
	4. After a successful login, a welcome box appears. Click OK to continue.
	Operator Setup

	Note You must be logged in as an operator with “Full Access” to create, edit, or delete other operators.
	Setting Up the Modem
	1. Start ToolBox. The first time you start ToolBox you’ll see the message: “Verify COM port selection by choosing Modem from the Setup menu. Be sure to use the OK button to close the Modem Setup Dialog.” Click OK to accept the message.
	2. Choose Modem Selection from the Setup menu.
	3. Select your modem from the list of available modems in the Modem Selec tion dialog box. (If you are using a GE Interlogix modem, select Securcomm DL110 (Speaker On).) Click OK.
	4. From the Setup menu, select Modem or click on the Modem button on the toolbar. If you selected a modem in Step 3, the Modem Setup dia log box displays the automatic settings for Init String, Dial Prefix, Dial Suffix, and Answer String.
	5. Select your modem’s COM port from the COM Port drop- down menu.


	Important ! Windows NT users must have the FIFO buffers disabled on the COM port ToolBox will be using. If they are not disabled, communications with alarm panels will fail due to the timin errors caused by data buffereing. ToolBox will remin...
	Table 3: Disabling FIFO buffers
	6. Type the incoming phone line number for the modem in the Incoming Phone Num ber field.


	Note You should not have to change the remaining modem settings if you are using a compatible modem. See Table 2 (in Part One) for a list of compatible modems. Refer to the Troubleshoot ing section if your modem isn’t working with ToolBox.
	7. Click OK to accept the changes. A message may appear prompting you to restart the system. Click OK.
	8. A COM Settings Changed message appears stating that the downloader must be restarted for any changes to take effect. Click OK to continue.
	9. From the Logout menu, choose Exit. Click Yes in response to “Are you sure you want to exit?”
	10. Restart if prompted, to enable the new modem setup.
	System Setup
	Unscheduled Calls
	Load Conflicts
	Auto Logout



	Part Three: Your ToolBox Accounts
	Setting Up a New ToolBox Account
	1. From the Account menu, select New, or click on the New Account button on the toolbar. The Create New Account dialog box appears.
	2. Select the panel type that matches the customer’s panel in the list. You can create your own tem plates for each panel.
	3. Enter the 5-digit account number in the New Account Number field. This is the same number the CS-4000 or CS-5000 uses, without the dash (XX-XXX). Concord, Concord Express and Simon 3 allow account numbers from 1 to 10 digits.

	Note Account Perfixes are dis abled in this version of Tool Box.
	4. Select from the pull down menu an account prefix. The account prefix groups accounts by central station (see Creating Acccount Prefixes).
	5. You can select a folder from the pull down menu. Folders are used to group accounts.
	6. Click the Create button. You can either edit the new account immediately, or return to the main screen. Let’s click Yes and edit the new account.
	7. The title bar lists the account number and the panel type. All of the panel settings are grouped according to tabs.
	Selecting an Existing ToolBox Account
	1. From the Account menu, choose Edit, or click on the Edit Account button on the toolbar. The Select Account dialog box appears.
	2. Select the account you want to edit from the list. To sort by ascending or descending order, simply click on a column heading.
	3. Click OK to open the account.

	Account Settings
	Creating Account Prefixes
	1. Open the ToolBox.ini file found in the Windows, or WinNT directory.
	2. Under the “[SystemSetup]” section add the line “PrefixMenuEnable = 1”.
	3. Save and then close the file.
	1. From the Setup menu select Auto Create Accounts, then New Account Prefix.
	2. In the Account Prefix field enter a 1-15 character (0-9, A-Z) account prefix.
	3. In the CS Phone Number field enter the central station phone number you want connected to the prefix.
	4. In the Comment field enter a description of the account prefix or central station.



	Part Four: Setting Up a Job
	Understanding Job Basics
	Upload from Panel
	Download to Panel
	Merge with Panel
	1. Learn in touchpad and sensor information on-site.
	2. Enter all other settings into the ToolBox account.
	3. Select Merge with Panel in the Job Informa tion dialog box. This enables a list of cate gory items from which you can select to download to the panel. If you would like to upload the panel settings to the ToolBox account, leave the item unselected.


	Creating a Job
	Preparing a Job in ToolBox
	1. From the Jobs menu, select New, or click on the New Job button on the toolbar. The Create New Job dialog box appears.
	2. Select the account that will be in the new job.
	3. Click the Create button to create the new job. The Job Information dialog box appears. (See the figure on the next page.)
	4. Enter the settings for the job. You don’t need to run the job immediately, but the fol lowing criteria must be met in order for the jobs to run:
	5. An onscreen message may appear stating “Start time is passed. Job will begin immediately. Accept?” Click Yes. ToolBox is now ready to accept call-in jobs or to execute call-out jobs. ToolBox will make its calls out when the modem is free, ...

	When the Panel is Calling ToolBox . . .
	1. Make sure the panel is connected to the phone line.
	2. Program the panel account number into the panel.
	3. Program the ToolBox modem phone number into the panel according to Table 4.
	Table 4: Initiating the Call-In Job

	When ToolBox is Calling the Panel . . .
	1. Make sure the premises phone number is entered correctly in the Phones tab.
	2. Program the ToolBox modem phone number into the panel according to Table 4.
	Table 5: Panel Settings for Call-out Jobs


	Modifying a Job
	Copying a Job
	Editing a Job

	Note You cannot access (edit) a job currently in progress.
	Viewing a Job
	Deleting a Job
	Job Logs
	Status Bar
	Job Status Window
	Logging Out or Exiting ToolBox

	Note Exiting ToolBox does not delete a job. To stop a job that is in progress, simply delete it from the Jobs menu.

	Part Five: Database Management
	Backing Up and Importing Customer Accounts
	Note If you did not split the data base by specifying a differ ent administrator directory during installation then administrator files will be in the customer database directory. Backing up the customer database will auto matically back-up a...
	Backup the Database/Administrator Files
	1. Create a backup folder outside the ToolBox database or administrator directory where you will store backup files.
	2. When ToolBox is not running, copy all .mdx and .dbf files into the respective backup database or administrator directory.

	Restore the Database/Administrator Files
	Importing Databases
	Table 6: Database importing information
	1. Open the ToolBox DB Importer program from the Start menu.
	2. From the File menu choose the Source direc tory (either database or administrator).
	3. Select the database or administrator directory you want to import as the Source directory and click Open.
	4. Repeat steps 2 and 3 if necessary.
	5. From the File menu choose the database or administrator Desti nation directory.
	6. Select the appropriate Destination directory and click Open.
	7. Repeat steps 5 and 6 if necessary.
	8. Once all Source and Destina tion directories have been spec ified, click Convert on the Importer menu bar to import the selected database directo ries.



	Note The Database Importer can not convert databases con taining more than 10,000 accounts.
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